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Chapter 545

Equivalence Tests for
the Ratio of Two Means
in a Higher-Order
Cross-Over Design
(Log-Normal Data)
Introduction
This procedure calculates power and sample size of statistical tests of equivalence of two means of higher-order
cross-over designs when the analysis uses a t-test or equivalent. The parameter of interest is the ratio of the two
means. Schuirmann’s (1987) two one-sided tests (TOST) approach is used to test equivalence. Only a brief
introduction to the subject will be given here. For a comprehensive discussion on the subject, refer to Chen,
Chow, and Li (1997). The designs covered in this chapter are analyzed using what is called the ‘multiplicative
model’ in Chen et al (1997). The ‘additive model’ is covered in the procedure that uses differences. Note that the
multiplicative model is simply an additive model applied to the logarithmic transform of the original data.
Measurements are made on individuals that have been randomly assigned to one of several treatment sequences.
This cross-over design may be analyzed by a TOST equivalence test to show that the two means do not differ by
more than a small amount, called the margin of equivalence.

Cross-Over Designs
Senn (2002) defines a cross-over design as one in which each subject receives all treatments at least once and the
object is to study differences among the treatments. The name cross-over comes from the most common case in
which there are only two treatments. In this case, each subject crosses over from one treatment to another. It is
assumed that there is a washout period between treatments during which the response returns to its baseline value.
If this does not occur, there is said to be a carryover effect.
A 2x2 cross-over design refers to two treatments (periods) and two sequences (treatment orderings). One
sequence of treatments is treatment A followed by treatment B. The other sequence is B and then A. The design
includes a washout period between responses to make certain that the effects of the first drug do no carryover to
the second. Thus, the groups of subjects in this design are defined by the sequence in which the two treatments are
administered, not by the treatments they receive.
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Higher-Order Cross-Over Designs
Chen et al. (1997) present the results for four cross-over designs that are more complicated than the 2x2 design.
Assume that the two treatments are labeled A and B. The available designs are defined by the order and number
of times the two treatments are administered.

Balaam’s Design
Balaam’s design has four sequences with two treatments each. It is popular because it allows the intrasubject
variabilities to be estimated. The design is
Sequence
1
2
3
4

Period 1
A
B
A
B

Period 2
A
B
B
A

Two-Sequence Dual Design
This design has two sequences with three periods each. It is popular because it allows the intrasubject variabilities
to be estimated. The design is
Sequence
1
2

Period 1
A
B

Period 2
B
A

Period 3
B
A

Four-Period Design with Two Sequences
This design has two sequences of four periods each. The design is
Sequence
1
2

Period 1
A
B

Period 2
B
A

Period 3
B
A

Period 4
A
B

Four-Period Design with Four Sequences
This design has four sequences of four periods each. The design is
Sequence
1
2
1
2

Period 1
A
B
A
B

Period 2
A
B
B
A

Period 3
B
A
B
A

Period 4
B
A
A
B

Advantages of Cross-Over Designs
A comparison of treatments on the same subject is expected to be more precise. The increased precision often
translates into a smaller sample size. Also, patient enrollment may be easier to obtain because each patient will
receive both treatments.

Disadvantages of Cross-Over Designs
The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires
additional assumptions. In a cross-over experiment, it may be difficult to separate the treatment effect from the
time effect and the carry-over effect of the previous treatment.
These cross-over designs cannot be used when the treatment (or the measurement of the response) alters the
subject permanently. Hence, it cannot be used to compare treatments that are intended to provide a cure.
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Because subjects must be measured at least twice, it may be more difficult to keep patients enrolled in the study.
This is particularly true when the measurement process is painful, uncomfortable, embarrassing, or time
consuming.

Outline of an Equivalence Test
PASS follows the two one-sided tests approach described by Schuirmann (1987) and Phillips (1990). It will be
convenient to adopt the following specialized notation for the discussion of these tests.
Parameter

PASS Input/Output Interpretation

µT

Not used

Treatment mean. This is the treatment mean.

µR

Not used

Reference mean. This is the mean of a reference population.

φL ,φU

RL, RU

Margin of equivalence. These limits define an interval of the ratio of the
means in which their difference is so small that it may be ignored.

φ

R1

True ratio. This is the value of φ = µT / µ R at which the power is
calculated.

Note that the actual values of µT and µ R are not needed. Only their ratio is needed for power and sample size
calculations.
The null hypothesis of non-equivalence is

H 0 :φ ≤ φL or φ ≥ φU where φL < 1, φU > 1.
The alternative hypothesis of equivalence is

H1:φL < φ < φU

Log-Transformation
In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of
differences. This is because ratios can be interpreted as percentages, but differences must be interpreted as actual
amounts in their original scale. Also, the distributions of variables such as CMax or AUC are often skewed.
Hence, a common practice is to take the following steps in hypothesis testing.
1. State the statistical hypothesis in terms of a ratio.
2. Transform this into a hypothesis about the difference by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in the original ratio scale.
The details of step 2 for the alternative hypothesis are as follows.

φL < φ < φU
µ 
⇒ φL <  T  < φU
 µR 
⇒ ln(φL ) < {ln( µT ) − ln( µ R )} < ln(φU )
Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the
difference of two means on the logged scale.
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When performing an equivalence test on the difference between means, the usual procedure is to set the
equivalence limits symmetrically above and below zero. Thus, the equivalence limits will be plus or minus an
appropriate amount. The common practice is to do the same when the data are being analyzed on the log scale.
However, when symmetric limits are set on the log scale, they do not translate to symmetric limits on the original
scale. Instead, they translate to limits that are the inverses of each other.
Perhaps these concepts can best be understood by considering an example. Suppose the researchers have
determined that the lower equivalence limit should be 80% on the original scale. Since they are planning to use a
log scale for their analysis, they transform this limit into the log scale by taking the logarithm of 0.80. The result
is -0.223144. Wanting symmetric limits, they set the upper equivalence limit to 0.223144. Exponentiating this
value, they find that exp(0.223144) = 1.25. Note that 1/(0.80) = 1.25. Thus, the limits on the original scale are
80% and 125%, not 80% and 120%.
Using this procedure, appropriate equivalence limits for the ratio of two means can be easily determined. Here are
a few sets of equivalence limits for ratios.
Specified
Percent
Change
-25%
+25%
-20%
+20%
-10%
+10%

Lower
Limit
Original
Scale
75.0%
80.0%
80.0%
83.3%
90.0%
90.9%

Upper
Limit
Original
Scale
133.3%
125.0%
125.0%
120.0%
111.1%
110.0%

Lower
Limit
Log
Scale
-0.287682
-0.223144
-0.223144
-0.182322
-0.105361
-0.095310

Upper
Limit
Log
Scale
0.287682
0.223144
0.223144
0.182322
0.105361
0.095310

Note that negative percent-change values specify the lower limit first, while positive percent-change values
specify the upper limit first. After the first limit is found, the other limit is calculated as its inverse.

Coefficient of Variation
The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter is used to
represent the variation in the data because of a unique relationship that it has in the case of log-normal data.
Suppose the variable X is the logarithm of the original variable Y. That is, X = ln(Y) and Y = exp(X). Label the
mean and variance of X as 𝜇𝜇𝑋𝑋 and 𝜎𝜎𝑋𝑋2 , respectively. Similarly, label the mean and variance of Y as 𝜇𝜇𝑌𝑌 and 𝜎𝜎𝑌𝑌2 ,
respectively. If X is normally distributed, then Y is log-normally distributed. Julious (2004) presents the following
well-known relationships between these two variables
2
𝜎𝜎𝑋𝑋

𝜇𝜇𝑌𝑌 = 𝑒𝑒 𝜇𝜇𝑋𝑋+ 2

2

𝜎𝜎𝑌𝑌2 = 𝜇𝜇𝑌𝑌2 �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1�

From this relationship, the coefficient of variation of Y can be found to be
𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌 =

2

�𝜇𝜇𝑌𝑌2 �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1�
𝜇𝜇𝑌𝑌

= �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1
2

= �𝑒𝑒 𝜎𝜎𝑊𝑊 − 1
2

2
where 𝜎𝜎𝑊𝑊
is the within mean square error from the analysis of variance of the logged data. Solving this
relationship for 𝜎𝜎𝑋𝑋2 , the standard deviation of X can be stated in terms of the coefficient of variation of Y as
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Similarly, the mean of X is

𝜎𝜎𝑋𝑋 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1)
𝜇𝜇𝑋𝑋 = ln �

𝜇𝜇𝑌𝑌

�𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1

�

Thus, the hypotheses can be stated in the original (Y) scale and then power can be analyzed in the transformed
(X) scale.

Test Statistics
The analysis for assessing equivalence using higher-order cross-over designs is discussed in detail in Chapter 9 of
Chow and Liu (2000). Unfortunately, their presentation is too lengthy to give here. Their method involves the
computation of an analysis of variance to estimate the error variance. It also describes the construction of
confidence limits for appropriate contrasts. These confidence limits can then be compared to the equivalence
limits to test for equivalence. We refer you to their book for details.

Power Calculation
The power is given by

 ln(φU ) − ln(φ )


ln(φ ) − ln(φL ) 

− tV ,1−α  − TV  tV ,1−α −
Power (φ ) = TV 

CV
b
n
CV
b
n
/
/
m
m




where

CVm = exp(MSElog ged ) − 1 , T represents the cumulative t distribution, V and b depend on the design, and n is
the average number of subjects per sequence. Note that the constants V and b depend on the design as follows.
Design Type

Parameters (V,b)

Balaam’s Design

V = 4n – 3, b = 2.

Two-Sequence Dual Design

V = 4n – 4, b = 3/4.

Four-Period Design with Two Sequences

V = 6n – 5, b = 11/20.

Four-Period Design with Four Sequences

V = 12n – 5, b = 1/4.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power for a power analysis or Sample Size for sample size determination.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Note that there are two choices for finding Sample Size. Select Sample Size (Equal Per Sequence) when you want
the design to have an equal number of subjects per sequence. Select Sample Size (Exact) when you want to find
the exact sample size even though the number of subjects cannot be dividing equally among the sequences.
Select Power when you want to calculate the power of an experiment.

Test
Design Type
Specify which cross-over design that you want to analyze. These designs allow you to compare two means: a
treatment (A) and a reference (B). The designs assume that each subject is measured two or more times (or
periods) with ample time in between to wash-out the effect of the treatment.
A sequence is an ordering of the how A and B are applied. For example, 'ABA' means that the subjects are
measured three times: first treatment A, then B, then A again. Other possible sequences are BAB, AAB, and
BBA. Each design includes several sequences.
The design tries to balance the experiment so that each treatment occurs an equal number of times and after each
other treatment an equal number of times.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Total Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study (total subjects
in all sequences). This value must be an integer greater than one.
You may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.

Effect Size – Equivalence Limits
RU (Upper Equivalence Limit)
Enter the upper equivalence limit for the ratio of the two means. When the ratio of the means is between this value
and RL, the two means are said to be equivalent. The value must be greater than one. A popular choice is 1.25.
Note that this value is not a percentage.
If you enter 1/RL, then 1/RL will be calculated and used here. This choice is commonly used because RL and
1/RL give limits that are of equal magnitude on the log scale.
RL (Lower Equivalence Limit)
Enter the lower equivalence limit for the ratio of the two means. When the ratio of the means is between this value
and RU, the two means are said to be equivalent. The value must be less than one. A popular choice is 0.80. Note
that this value is not a percentage.
If you enter 1/RU, then 1/RU will be calculated and used here. This choice is commonly used because RU and
1/RU give limits that are of equal magnitude on the log scale.

Effect Size – True Ratio
R1 (True Ratio)
This is the value of the ratio of the two means at which the power is to be calculated. Usually, the ratio will be
assumed to be one. However, some authors recommend calculating the power using a ratio of 1.05 since this will
require a larger, more conservative, sample size.

Effect Size – Coefficient of Variation
COV (Coefficient of Variation of Y)
A response variable Y has mean μY and standard deviation σY. The coefficient of variation of Y, σY/μY, is used to
specify the variation in Y.
Suppose that Y is skewed, so a logarithmic transformation will be applied. That is, the variable X = Ln(Y) will be
analyzed using an appropriate ANOVA procedure. The analysis assumes that X is normally distributed with mean
μX and standard deviation σX. So Y is lognormal and X is normal. Power and sample size calculations are made on
X. However, interpretation may be easier in the Y scale.
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If Y is truly lognormal, there is a direct relationship between μY and σY and μX and σX. Using this relationship, it
can be shown that

Solving for σX, we obtain

𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌 = �𝐸𝐸𝐸𝐸𝐸𝐸(𝜎𝜎𝑋𝑋2 ) − 1
𝜎𝜎𝑋𝑋 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1)

There are two ways to obtain a value for COVY.

1. Calculate COVY directly from the mean and SD of a set of Y values obtained from a previous (or pilot) study.
2. Obtain σwX as the square root of the within mean square error in an ANOVA table of X. Then use the fact that
σX = σwX.
We have found that method 1 does not provide a reliable estimate of σX, so we recommend method 2.
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Example 1 – Finding Power
A company has opened a new manufacturing plant and wants to show that the drug produced in the new plant is
equivalent to that produced in the older plant. A two-sequence, dual cross-over design will be used to test the
equivalence of drugs produced at the two plants.
Researchers have decided to set the equivalence limits for the ratio at 0.80 and 1.25. Past experience leads the
researchers to set the COV to 0.40. The significance level is 0.05. The power will be computed assuming that the
true ratio is 0.96. Sample sizes between 10 and 80 will be included in the analysis.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Design Type ............................................ 3x2 (Three-Period, Two-Sequence Dual: ABB|BAA)
Alpha ....................................................... 0.05
N (Total Sample Size)............................. 10 20 30 40 60 80
RU (Upper Equivalence Limit) ................ 1.25
RL (Lower Equivalence Limit) ................. 1/RU
R1 (Mean Ratio) ..................................... 0.96
COV (Coefficient of Variation) ................ 0.40

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results of an Equivalence Test of the Mean Ratio in a Three-Period, Two-Sequence Dual Design
Treatment Sequences: ABB | BAA

Power
0.0000
0.3051
0.5858
0.7483
0.9035
0.9627

Sample
Size
N
10
20
30
40
60
80

Lower
Equiv
Limit
RL
0.800
0.800
0.800
0.800
0.800
0.800

Upper
Equiv
Limit
RU
1.250
1.250
1.250
1.250
1.250
1.250

Mean
Ratio
R1 (μT/μR)
0.960
0.960
0.960
0.960
0.960
0.960

Coef of
Variation
COV
0.4000
0.4000
0.4000
0.4000
0.4000
0.4000

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting non-equivalence when the means are equivalent.
N is the total number of subjects. They are divided evenly among all sequences.
RU & RL are the upper and lower equivalence limits. Ratios between these limits are equivalent.
R1 is the ratio of the means at which the power is computed.
COV is the coefficient of variation on the original scale.
Alpha is the probability of rejecting non-equivalence when the means are non-equivalent.
Summary Statements
In an equivalence test of means using two one-sided tests on data drawn from a three-period,
two-sequence dual cross-over design, a total sample size of 10 achieves 0% power at a 5%
significance level when the mean ratio (μT/μR) is 0.960, the coefficient of variation on the
original (unlogged) scale is 0.4000, and the equivalence limits are 0.800 and 1.250.

This report shows the power for the indicated scenarios. Note that 60 subjects will yield a power of just over
90%.

Plots Section

This plot shows the power versus the sample size.
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Example 2 – Finding Sample Size
Continuing with Example 1, the researchers want to find the exact sample size needed to achieve both 80% power
and 90% power.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size (Exact)
Design Type ............................................ 3x2 (Three-Period, Two-Sequence Dual: ABB|BAA)
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.05
RU (Upper Equivalence Limit) ................ 1.25
RL (Lower Equivalence Limit) ................. 1/RU
R1 (Mean Ratio) ..................................... 0.96
COV (Coefficient of Variation) ................ 0.40

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results of an Equivalence Test of the Mean Ratio in a Three-Period, Two-Sequence Dual Design
Design: Three-Period, Two-Sequence Dual Cross-Over
Treatment Sequences: ABB | BAA

Power
0.8026
0.9035

Sample
Size
N
45
60

Lower
Equiv
Limit
RL
0.800
0.800

Upper
Equiv
Limit
RU
1.250
1.250

Mean
Ratio
R1 (μT/μR)
0.960
0.960

Coef of
Variation
COV
0.4000
0.4000

Alpha
0.050
0.050

We note that 60 subjects are needed to achieve 90% power and 45 subjects are needed to achieve at least 80%
power.
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Example 3 – Validation using Chen et al. (1997)
Chen et al. (1997) page 761 presents a table of sample sizes for various parameter values for Balaam’s design. We
will reproduce entries from the first and seventeenth lines of the table in which the COV is 10%, the equivalence
limits are 0.8 and 1.25, the actual ratio of between the means is 1, the power values are 80% and 90%, and the
significance level is 0.05. Chen reports total sample sizes of 16 and 20. We will now setup this example in PASS.
The COV entered by Chen is the COV of the logged data. Since PASS requires the COV of the original data, we
must use the relationship

COVY = eσ w − 1
2

= e 0.1 − 1
2

= e 0.01 − 1
.
= 010025
to obtain the appropriate value of COV.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size (Equal Per Sequence)
Design Type ............................................ 2x4 (Balaam: AA|BB|AB|BA)
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.05
RU (Upper Equivalence Limit) ................ 1.25
RL (Lower Equivalence Limit) ................. 1/RU
R1 (Mean Ratio) ..................................... 1.0
COV (Coefficient of Variation) ................ 0.10025

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results of an Equivalence Test of the Mean Ratio in a Two-Period, Four-Sequence (Balaam) Design
Treatment Sequences: AA | BB | AB | BA

Power
0.8106
0.9085

Sample
Size
N
16
20

Lower
Equiv
Limit
RL
0.800
0.800

Upper
Equiv
Limit
RU
1.250
1.250

Mean
Ratio
R1 (μT/μR)
1.000
1.000

Coef of
Variation
COV
0.1003
0.1003

Alpha
0.050
0.050

Note that PASS has obtained the same samples sizes as Chen et al. (1997).
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